# Table of Contents

Revision History..........................................................................................................................3

Chapter 1: Introduction..................................................................................................................4

Chapter 2: System Setup using the Programming Cable.........................................................6
  Standard ESD Measures................................................................................................................ 6
  Connecting and Disconnecting the Ribbon Cable................................................................ 7
  Connecting the Alveo Programming Module........................................................................ 10

Chapter 3: Programming Cable Component Descriptions....................................................14
  Programming Module Specifications....................................................................................... 14
  Debug Header for Connecting with the Main Card................................................................. 15
  Micro USB Connectors........................................................................................................... 15
  Programming Cable................................................................................................................. 16

Chapter 4: Programming the Alveo Data Center Accelerator Card.......................................17
  Steps to Connect and Program the Alveo Data Center Accelerator Card.......................... 17

Appendix A: Regulatory and Compliance Information.........................................................21
  CE Information......................................................................................................................... 21
  Compliance Markings.............................................................................................................. 22

Appendix B: Additional Resources and Legal Notices.......................................................23
  Xilinx Resources...................................................................................................................... 23
  Documentation Navigator and Design Hubs........................................................................ 23
  Please Read: Important Legal Notices................................................................................. 24
The following table shows the revision history for this document:

<table>
<thead>
<tr>
<th>Section</th>
<th>Revision Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>12/02/2019 Version 1.1</strong></td>
<td></td>
</tr>
<tr>
<td>General updates</td>
<td>Revised outline of document</td>
</tr>
<tr>
<td>Chapter 1: Introduction</td>
<td>Updated Figure 1: Alveo Programming Module Interface Locations. Added Note 1 to Table 1: Alveo Programming Module Interface Descriptions.</td>
</tr>
<tr>
<td>Connecting and Disconnecting the Ribbon Cable</td>
<td>Updated Figure 3 photo</td>
</tr>
<tr>
<td>Connecting the Alveo Programming Module</td>
<td>Updated Figure 5, Figure 6, and Figure 7 photos</td>
</tr>
<tr>
<td>Programming Module Specifications</td>
<td>Added adapter specifications</td>
</tr>
<tr>
<td><strong>9/17/2019 Version 2019.1</strong></td>
<td></td>
</tr>
<tr>
<td>General updates</td>
<td>No technical content updates</td>
</tr>
<tr>
<td><strong>8/30/2019 Version 2019.1</strong></td>
<td></td>
</tr>
<tr>
<td>Chapter 1: Introduction</td>
<td>Provided a general overview of the card</td>
</tr>
<tr>
<td></td>
<td>Provided names of the supported cards and links to each</td>
</tr>
<tr>
<td>Chapter 2: Prevention ESD Damage</td>
<td>Updated Figure 1</td>
</tr>
<tr>
<td></td>
<td>Updated Table 1 through Table 4</td>
</tr>
<tr>
<td>Chapter 3: Setting Up the System</td>
<td>Updated Figure 2 through Figure 7</td>
</tr>
<tr>
<td></td>
<td>Revised steps to set up ribbon cable</td>
</tr>
<tr>
<td></td>
<td>Added Connecting the Alveo Programming Module</td>
</tr>
<tr>
<td>Chapter 4: Programming the Alveo Card</td>
<td>Described how to connect and program the card</td>
</tr>
<tr>
<td>Appendix A: Board Specifications</td>
<td>Added physical descriptions of the board</td>
</tr>
<tr>
<td><strong>6/21/2019 Version 2019.1</strong></td>
<td></td>
</tr>
<tr>
<td>Initial release.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Introduction

The Alveo™ programming cable provides development access for debug-port enabled Alveo data center accelerator cards allowing the card to be programmed. The Alveo programming cable consists of a programming module, ribbon cable, and USB cable. Debug-port enabled Alveo data center accelerator cards have a 2x15-pin maintenance connector that connects to the programming module through a ribbon cable. The programming module connects to the host computer through a micro-USB that also provides power. The following cards are debug-port enabled and support the Alveo programming cable.

- U50/U50DD

The following figure shows the Alveo programming module with available interface call-outs. The following table describes each call-out. Chapter 3: Programming Cable Component Descriptions gives additional information on each component.

Figure 1: Alveo Programming Module Interface Locations
### Table 1: Alveo Programming Module Interface Descriptions

<table>
<thead>
<tr>
<th>Call-out</th>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2x15-pin debug connector</td>
<td>Provides connection between the programming module and Alveo data center accelerator card. Used for programming the programmable device.</td>
</tr>
<tr>
<td>2</td>
<td>Micro USB connector port 1</td>
<td>Provides connection between host system, with Vivado® Design Suite installed, and the programming module. Used for programming the Alveo data center accelerator card.</td>
</tr>
<tr>
<td>3</td>
<td>Unused</td>
<td>Reserved. Unused for development tool flows.</td>
</tr>
</tbody>
</table>

**Notes:**

1. An Alveo programming cable (HW-DMB-1-G) is included with the purchase of the A-U50DD-P00G-ES3-G. Customers purchasing the A-U50-P00G-PQ-G need to purchase the Alveo programming cable separately at [Alveo Accessories](https://www.xilinx.com).
Chapter 2

System Setup using the Programming Cable

Standard ESD Measures

CAUTION! ESD can damage electronic components when they are improperly handled, and can result in total or intermittent failures. Always follow ESD-prevention procedures when removing and replacing components.

To prevent ESD damage:

- Attach a wrist strap to an unpainted metal surface of your hardware to prevent electrostatic discharge from damaging your hardware.
- When you are using a wrist strap, follow all electrical safety procedures. A wrist strap is for static control. It does not increase or decrease your risk of receiving electric shock when you are using or working on electrical equipment.
- If you do not have a wrist strap, before you remove the product from ESD packaging and installing or replacing hardware, touch an unpainted metal surface of the system for a minimum of five seconds.
- Do not remove the device from the antistatic bag until you are ready to install the device in the system.
- With the device still in its antistatic bag, touch it to the metal frame of the system.
- Grasp cards and boards by the edges. Avoid touching the components and gold connectors on the adapter.
- If you need to lay the device down while it is out of the antistatic bag, lay it on the antistatic bag. Before you pick it up again, touch the antistatic bag and the metal frame of the system at the same time.
- Handle the devices carefully to prevent permanent damage.
Connecting and Disconnecting the Ribbon Cable

A 2x15 ribbon cable is required to connect between the Alveo™ data center accelerator card and the programming module. See Programming Cable.

Connecting the Ribbon Cable

When connecting the ribbon cable and programming module, align the cable key with the spacing on the maintenance connector. The cable key is shown in the following image.

*Figure 2: Ribbon Cable Key*

---

**IMPORTANT!** The ribbon length you use can vary depending on your system setup. For ribbon cable length greater than five inches, when programming the card the JTAG transfer frequency used by the Vivado® hardware manager must be reduced from 15 MHz to 10 MHz. Complete details are discussed in Chapter 4: Programming the Alveo Data Center Accelerator Card.

Debug-port enabled Alveo data center accelerator cards have a 2x15-pin maintenance connector that attaches to the corresponding connector on the programming module through the ribbon cable. The corresponding connector on the programming module is shown in Figure 3. Figure 4 shows the ribbon cable attaching to the 2x15-pin maintenance connector of the Alveo U50 data center accelerator card.
Figure 3: Connecting Ribbon Cable to Debug Connector
When attaching the cable, apply gentle pressure and ensure the cable has a tight connection.

**IMPORTANT!** Do not apply excessive force when connecting the ribbon cable as the connector pins can be damaged or bent.

**Disconnecting the Ribbon Cable**

When removing the ribbon from either the Alveo data center accelerator card or the programming module, firmly hold the ribbon connector and pull the cable out in a straight line. Twisting or rotating the connector will damage the connector pins on the Alveo data center accelerator card or the programming module.
Connecting the Alveo Programming Module

The procedures in this section outlines the programming module connection to the Alveo data center accelerator card procedures. Depending on your system setup, the following installation steps could differ. The following example uses a 15-inch cable. Two adjacent PCIe® slots are necessary: one for the Alveo data center accelerator card and the other for ribbon cable access.

1. Before installing the Alveo data center accelerator card, connect one end of the ribbon cable to the 2x15-pin maintenance port on the Alveo data center accelerator card following the instructions outlined in Connecting the Ribbon Cable.

2. Power off the server and install the Alveo data center accelerator card in the server. See the Alveo U50 Data Center Accelerator Card Installation Guide (UG1370) for Alveo data center accelerator card installation steps.

3. When the card is installed, guide the ribbon cable through the adjacent PCIe slot, providing enough length to attach it to the Alveo programming module.

4. Attach the other end of the ribbon cable to the maintenance connector on the Alveo programming module following the instructions outlined in Connecting the Ribbon Cable. The following figures show the subsequent setup from the top and side views.
Figure 5: Installed Alveo Data Center Accelerator Card Connected to Alveo Programming Module – Top View
5. Replace the server cover.

6. Attach the micro-USB cable to USB port 1 of the Alveo programming module. The following figure shows both the ribbon (on the left side) and USB connected (on the right side).
7. Guide the other end of the micro-USB cable to a location that is accessible by the host computer/laptop with the Vivado® Design Suite installed.

The Alveo programming module is successfully installed and the server can now be powered on.
Programming Cable Component Descriptions

This chapter provides a functional description of the components of the Alveo™ programming cable.

Programming Module Specifications

Dimensions (Square Form Factor)

Figure 8: Programming Module Dimensions

![Programming Module Dimensions Diagram]
The following dimensions are of the PCB inside the programming module:

- Height: 2.5 inch (6.35 cm)
- Length: 2.5 inch (6.35 cm)
- Thickness (±5%): 0.062 inch (0.1574 cm)

**Environmental**

- Operating Temperature: 0°C to +55°C
- Storage Temperature: −40°C to +75°C
- Humidity: 10% to 90% non-condensing

### Debug Header for Connecting with the Main Card

The programming module, populated with a 2x15-pin debug connector (shown as call-out 1 in Figure 1), connects to the Alveo Data Center accelerator card with a ribbon cable. The 2x15 connector details are listed.

- Manufacturer: SAMTEC
- Part number: FTSH-115-01-F-D-RA-K
- Description: CONN HEADER R/A 30POS 1.27MM

The connector debug header pin definitions are listed in Table 2: Micro-USB Connectors.

### Micro USB Connectors

The programming module has two micro-USB connectors (call-outs 2 and 3 in Figure 1), one for each FT4232 USB to multi-protocol converter. Connect the external micro-USB cable from the host to the micro-USB connector 1 (call-out 2 in Figure 1). The micro-USB connector number 2 should be left unused (call-out 3 in Figure 1). The pin description of the micro-USB connector is listed in the following table.
Table 2: Micro-USB Connectors

<table>
<thead>
<tr>
<th>Pin Number</th>
<th>Signal Name</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USB_VBUS</td>
<td>USB power</td>
</tr>
<tr>
<td>2</td>
<td>USB_DN</td>
<td>USB differential data –</td>
</tr>
<tr>
<td>3</td>
<td>USB_DP</td>
<td>USB differential data +</td>
</tr>
<tr>
<td>4</td>
<td>USB_ID</td>
<td>USB ID</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>GND</td>
<td>Shield ground</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>GND</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>GND</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>GND</td>
<td></td>
</tr>
</tbody>
</table>

Programming Cable

The required cables for the programming module are listed in the following table.

Table 3: Maintenance Board Accessories

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Quantity per Board</th>
<th>Description</th>
<th>Manufacturer</th>
<th>Manufacturer Part Number</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Ribbon cables/IDC cables .050” tiger-eye IDC ribbon cable assembly, 1.27 mm, 30 position, 6” length, female to female</td>
<td>Samtec</td>
<td>FFSD-15-D-06.00-01-N</td>
<td>Connection between programming module and Alveo data center accelerator card connector.</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Cable USB-A TO micro USB-B 2M</td>
<td>Assmann</td>
<td>AK67421-2-R</td>
<td>Connection between programming module and external device (i.e., host computer)</td>
</tr>
</tbody>
</table>
Chapter 4

Programming the Alveo Data Center Accelerator Card

If you are using the Vitis™ IDE flow, the Alveo U50 Data Center Accelerator Card Installation Guide (UG1370) has software installation instructions, including programming the target platform to the Alveo™ data center accelerator card. Traditional RTL-flow Alveo data center accelerator cards, enabled with the 2x15-maintenance port, can be programmed using the Alveo programming module and the Vivado® Design Suite hardware manager application. To use this flow:

- Vivado® Design Suite 2019.1 or later hardware manager must be installed on your host machine or laptop to program the device via JTAG.
- Alveo data center accelerator card must be installed (see Connecting the Alveo Programming Module) and the server powered on.
- DMC connected as described in Connecting the Alveo Programming Module.

Steps to Connect and Program the Alveo Data Center Accelerator Card

To connect and program the Alveo data center accelerator card using the Vivado Design Suite hardware manager:

1. Attach the free end of the USB cable (coming from the Alveo programming module) to the host computer to connect the module with the host computer.
2. Start the Vivado Design Suite on the host computer.
3. Open the hardware manager by selecting Flow Navigator → Open Hardware Manager.
4. Select Tools → Auto Connect to open the target. A window, similar to one shown in the following example opens. In this case, an Alveo U50 is connected.
When using a ribbon cable longer than 5 inches, the JTAG transfer frequency must be changed from 15 MHz to 10 MHz. This lower frequency ensures proper signal integrity and successful programming. To change the JTAG transfer frequency to 10 MHz, run the following Tcl command in the hardware manager command line as shown in the following image: 

```
set_property PARAM.FREQUENCY 1000000 [current_hw_target]
```

5. Choose the memory configuration device on the card.
   a. Right click on the target opened in this example xc50_0, and select Add Configuration Memory Device.
   b. Select the memory associated with the card installed, and click OK. The following example selects mt25qu01g-spi-x1_x2_x4.
   c. When prompted to program the configuration memory device, click OK.
6. Select the desired MCS file.

7. In the Address Range drop-down list, select *Entire Configuration Memory Device* and click OK.
8. Disconnect the card in the Vivado Design Suite hardware manager.

9. Disconnect the USB cable from your host computer.

10. Power-cycle the card. The card is now updated.
Regulatory and Compliance Information

This product is designed and tested to conform to the European Union directives and standards described in this section.

For Technical Support, open a Support Service Request.

---

CE Information

**CE Directives**

2006/95/EC, Low Voltage Directive (LVD)


**CE Standards**

EN standards are maintained by the European Committee for Electrotechnical Standardization (CENELEC). IEC standards are maintained by the International Electrotechnical Commission (IEC).

**CE Electromagnetic Compatibility**


EN 55024:2010, Information Technology Equipment Immunity Characteristics – Limits and Methods of Measurement

This is a Class A product. In a domestic environment, this product can cause radio interference, in which case the user might be required to take adequate measures.

**CE Safety**

IEC 60950-1:2005, Information technology equipment – Safety, Part 1: General requirements

EN 60950-1:2006, Information technology equipment – Safety, Part 1: General requirements
Compliance Markings

In August of 2005, the European Union (EU) implemented the EU Waste Electrical and Electronic Equipment (WEEE) Directive 2002/96/EC and later the WEEE Recast Directive 2012/19/EU. These directives require Producers of electronic and electrical equipment (EEE) to manage and finance the collection, reuse, recycling and to appropriately treat WEEE that the Producer places on the EU market after August 13, 2005. The goal of this directive is to minimize the volume of electrical and electronic waste disposal and to encourage re-use and recycling at the end of life.

Xilinx has met its national obligations to the EU WEEE Directive by registering in those countries to which Xilinx is an importer. Xilinx has also elected to join WEEE Compliance Schemes in some countries to help manage customer returns at end-of-life.

If you have purchased Xilinx-branded electrical or electronic products in the EU and are intending to discard these products at the end of their useful life, please do not dispose of them with your other household or municipal waste. Xilinx has labeled its branded electronic products with the WEEE Symbol to alert our customers that products bearing this label should not be disposed of in a landfill or with municipal or household waste in the EU.

This product complies with Directive 2002/95/EC on the restriction of hazardous substances (RoHS) in electrical and electronic equipment.

Appendix B

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx Support.

Documentation Navigator and Design Hubs

Xilinx® Documentation Navigator (DocNav) provides access to Xilinx documents, videos, and support resources, which you can filter and search to find information. To open DocNav:

- From the Vivado® IDE, select Help → Documentation and Tutorials.
- On Windows, select Start → All Programs → Xilinx Design Tools → DocNav.
- At the Linux command prompt, enter docnav.

Xilinx Design Hubs provide links to documentation organized by design tasks and other topics, which you can use to learn key concepts and address frequently asked questions. To access the Design Hubs:

- In DocNav, click the Design Hubs View tab.
- On the Xilinx website, see the Design Hubs page.

Note: For more information on DocNav, see the Documentation Navigator page on the Xilinx website.
Please Read: Important Legal Notices

The information disclosed to you hereunder (the "Materials") is provided solely for the selection and use of Xilinx products. To the maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical applications, please refer to Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS "XA" IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE ("SAFETY APPLICATION") UNLESS THERE IS A SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD ("SAFETY DESIGN"). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT LIABILITY.

Copyright

© Copyright 2019 Xilinx, Inc. Xilinx, the Xilinx logo, Alveo, Artix, Kintex, Spartan, Versal, Virtex, Vivado, Zynq, and other designated brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.